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Polycom RealPresence Resource Manager

Polycom announces the release of version 10.9 software for Polycom RealPresence Resource Manager. 
This document provides the latest information about Polycom RealPresence Resource Manager.
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What’s New in Release 10.9
RealPresence Resource Manager includes the features and functionality of previous releases and includes 
the following new features:

● Support for Amazon Web Services (AWS) and Microsoft Azure Deployments

● Support for Poly Rack Server R240

● Support for Poly Trio C60

● Support for Poly CCX 400 Business Media Phones

● Audio Licenses Used for Poly EagleEye Cube USB Camera, Poly Studio, and Polycom Pano

● Set Alert Level for Poly Trio Visual+ or Poly Trio VisualPro Disconnection

● Other Changes in This Release

Support for Amazon Web Services (AWS) and 
Microsoft Azure Deployments 
You can now deploy RealPresence Resource Manager in the Amazon AWS or Microsoft Azure.

Support for Poly Rack Server R240 
You can now install RealPresence Resource Manager on the Poly Rack Server R240. On the system 
Dashboard, the R240 servers display as Rev I in the System Info pane.

Support for Poly Trio C60
RealPresence Resource Manager can monitor, provision, and upgrade Poly Trio C60 in the following ways:

● Add, edit, delete, view, and search for Poly Trio C60 on the Endpoint > Monitor page.

● Import and export Poly Trio C60 systems via a CSV file.

● Provision and upgrade Poly Trio C60 on the Endpoint > UC Management menu.

Support for Poly CCX 400 Business Media Phones
RealPresence Resource Manager can monitor, provision, and upgrade CCX 400 business media phones in 
the following ways:

● Add, edit, delete, view, and search for these phones on the Endpoint > Monitor page.

● Import and export these phones via a CSV file.

● Provision and upgrade these phones on the Endpoint > UC Management menu.
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Audio Licenses Used for Poly EagleEye Cube USB 
Camera, Poly Studio, and Polycom Pano
Poly EagleEye Cube USB Camera, Poly Studio, and Polycom Pano consume audio licenses instead of 
video licenses.

Set Alert Level for Poly Trio Visual+ or Poly Trio 
VisualPro Disconnection
RealPresence Resource Manager can report alerts when a paired Poly Trio Visual+ or Poly Trio VisualPro 
is disconnected from the RealPresence Resource Manager system.

You can set the alert level on the Alert > Alert Level Settings page.

To set the alert level for Poly Trio Visual+ or Poly Trio VisualPro disconnection:

1 On the system web interface, go to Alert > Alert Level Settings.

2 Select the Endpoints tab.

3 Change the levels for the Unprovisioned Paired Device Disconnected (Trio Visual+ or Trio 
VisualPro) option as desired.

4 Select Update.

Other Changes in This Release
This release includes the following feature updates:

● (Dynamic Management) Support Territory as a new condition type. You can use territory name as 
the attribute to define the condition for your provisioning rules.

● Support for the .7z file type as an endpoint software image you can load to RealPresence Resource 
Manager.

● Support for adding G7500, Studio X50, and Studio X30 manually on the Endpoint > Monitor View 
page.

● Support for rebooting G7500, Studio X50, and Studio X30 remotely on the Endpoint > Monitor View 
> More page.

● Support for launching the RealPresence Resource Manager Web Admin Utility for G7500, Studio 
X50, and Studio X30 from the RealPresence Resource Manager system web interface.

● Support for jcmd in the RealPresence Resource Manager image, along with a script for taking heap 
dumps to help analyze heap memory and threading issues.

To view the latest Polycom product documentation, visit the Poly Online Support Center.

https://www.poly.com/us/en/support
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Release History
This following table lists the release history of RealPresence Resource Manager from 10.0.0.

Release History

Release API 
Release

System Release 
Date

Features

10.9 3.2.7 CentOS 6.10

Postgres 9.5.15

OpenJDK 
1.8.0_191

October 
2020

• Support for Amazon Web Services (AWS) and Microsoft 
Azure Deployments

• Support for Poly Rack Server 240.

• Support for Poly Trio C60

• Support for Poly CCX 400 Business Media Phones

• Audio Licenses Used for Poly EagleEye Cube USB 
Camera, Poly Studio, and Polycom Pano

• Support for Poly Trio Visual+ or Poly Trio VisualPro 
Disconnectivity Alert

10.8 3.2.7 CentOS 6.10

Postgres 9.5.15

OpenJDK 
1.8.0_191

December 
2019

• Support for Polycom RealPresence Poly Studio X30 and 
X50

• Support for Poly TC8

• Support for Poly Trio 8300

• Support for Poly CCX Business Media Phones

• Polycom Rack Server Shipments Updates

10.7.0 3.2.7 CentOS 6.10

Postgres 9.5.15

OpenJDK 
1.8.0_191

July 2019 • Support for Polycom G7500 Provisioning, Monitoring, 
and Upgrading

• Support for Polycom EagleEye Cube USB Camera 
Monitoring, Provisioning, and Upgrading

• Support for Polycom RealPresence Video App SDK API 
Monitoring and License Control

• Support Polycom EagleEye Cube HDCI Camera as 
Peripheral

• Other Changes in This Release

10.6.0 3.2.6 CentOS 6.10

Postgres 9.5.15

OpenJDK 
1.8.0_191

March 
2019

• Support for Polycom Studio Monitoring, Provisioning, 
and Upgrading

• Authorizing Users with JSON Web Token

• Support for Additional Phone Configuration Profiles

• Other Changes in This Release
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10.5.0 3.2.5 CentOS 6.10

Postgres 9.5.14

OpenJDK 
1.8.0_181

December 
2018

• Support Polycom RealPresence DMA Edge 
Configuration

• Support for Resetting Phones via REST API

• Support for Getting or Setting Phone Parameters via 
REST API

• Simple Certificate Enrollment Protocol (SCEP) 
Provisioning Support

• Support for Sending Pooled Conference Name to 
RealPresence DMA via REST API

• Support LDAP Channel Binding Token

• Support for More Phone Configuration Profiles

• Other Changes in This Release

10.4.0 3.2.4 CentOS 6.9

Postgres 9.5.9

OpenJDK 
1.8.0.151

July 2018 • Support for New Polycom RealPresence Clariti 
Licenses

• Support for Provisioning Polycom RealPresence Group 
Series Via Poly Trio

• New Dynamic Provisioning Parameters Support for 
Polycom Pano and RealPresence Group Series

• Enhancements to Phone Configuration Files

• Enhancements to Ciphers Support

• Support for More Phone Configuration Profiles

• Support for New Devices

• RealPresence Platform API Version Updates to 3.2.4 
without API Changes

10.3.0 3.2.3 CentOS 6.9

Postgres 9.5.9

OpenJDK 
1.8.0.151

December 
2017

• Support for Polycom Pano

• Support for Selecting SMB Versions

• Support for Two New Log Streams

• Support for More Phone Configuration Profiles

• Dashboard Enhancements

• Sites Enhancements

• Adding Polycom VBP Automatically No Longer 
Supported

Release History

Release API 
Release

System Release 
Date

Features
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10.2.0 3.2.3 CentOS 6.9

Postgres 9.5.6

OpenJDK 
1.8.0.121

October 
2017

• Video Endpoint and Audio Phones License 
Enhancement (Non-Polycom® RealPresence Clariti™)

• Filter Enhancements

• Support for User Defined Attributes in CSV File

• Assign Auto-Added Phones to Default Endpoint Groups

• Support for More Phone Configuration Profiles

• Phone Software Updates Enhancements

• Support for Uploading Phone Configuration Files

• Support for Updating Endpoint Model Definition

• Disk Space Usage Notice for Phone Software Updates 
and Resource Files

• Support for New Devices

• Polycom® Concierge No Longer Supported

10.1.0 3.2.3 CentOS 6.9

Postgres 9.5.6

OpenJDK 
1.8.0.121

April 2017 • Enhanced Audio Phone Management 

• Pre-defined Domain and Password for Software 
Endpoints Control

• Support for Guest Book Filter

• Support for Manually Updating Endpoint Name

• Support for Standalone RealPresence Platform Director 
Migration

• Support for New Network Devices for Remote Alert 
Profile

• Support for New Devices

10.0.1 3.2.2 CentOS 6.6

Postgres 9.3

OpenJDK 
1.8.0.45

October 
2016

• Resolved some known issues.

• Support for Polycom Rack Server 230.

10.0.0 3.2.2 CentOS 6.6

Postgres 9.3

OpenJDK 
1.8.0.45

August 
2016

• Unified Management of RealPresence Clariti Video 
Infrastructure

• New HTML5 Look and Feel

• Support for Selectable Provisioning for RealPresence 
Group Series

• Improved Conference Scheduling and Monitoring 
Interface

• Support for Security Baselines

• Support for USB Deployment (Appliance Only)

• API Change: the changed API is *plcm_user_role*.  
The length of the *description* parameter has been 
increased from 120 characters to 240 characters.

Release History

Release API 
Release

System Release 
Date

Features



 RealPresence Resource Manager Release Notes Version 10.9

Polycom, Inc. 7

Security Updates
Security enhancements on TCP port 6000 to fix the Java Debug Wire Protocol Remote Code Execution 
vulnerability. 

Please refer to the Polycom Security Center for information about known and resolved security 
vulnerabilities.

Products Tested with This Release
Polycom products are tested extensively with a wide range of products. The table below lists the products 
that have been tested for compatibility with this release.

Polycom strives to support any system that is standards-compliant, and Poly investigates reports of Poly 
systems that don’t interoperate with other standards-compliant vendor systems. 

Note that the following list is not a complete inventory of compatible equipment, but the products that have 
been tested with this release.

Hypervisor Environments for Virtual Editions

Product Tested Versions

VMware vSphere Platform 6.0, 6.5, 6.7

Microsoft Hyper-V 2012, 2016

Polycom Video Endpoints

Product Tested Versions

Polycom HDX 3.1.14

Polycom RealPresence Debut 1.3.3

Polycom RealPresence Group Series (300, 310, 500, 550, 
and 700)

6.2.1.2

Poly G7500 3.2.1

Poly Studio X30

Poly Studio X50

3.2.1

Polycom RealPresence Mobile 3.10

Polycom RealPresence Desktop 3.10

Polycom VVX 1500 5.9.3, 6.1.0

http://support.polycom.com/PolycomService/support/us/support/documentation/security_center.html
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Polycom UC Endpoints

Product Tested Versions

Poly Trio 8800 5.9.1

Poly Trio 8500 5.9.1

Poly Trio 8300 5.9.1

Poly Trio Visual+ 5.9.1

Poly Trio C60 1.0

Poly Trio VisualPro 6.2.1

Polycom VVX 501

Polycom VVX 601

Polycom VVX 1500

5.9.3

Polycom VVX 450 5.9.3

Poly CCX 400 6.2.11

Poly CCX 500 6.2.11

Poly CCX 600 6.2.11

Poly CCX 700 6.2.11

Endpoint Peripherals

Product Tested Versions

Poly TC8 1.0

Polycom Network Devices

Product Tested Versions

Polycom RealPresence Collaboration Server, Virtual Edition 8.8.0, 8.8.1

Polycom RealPresence Collaboration Server (RMX) 1800 8.8.0, 8.8.1

Polycom RealPresence Collaboration Server (RMX) 
2000/4000 with MPMrx

8.8.0, 8.8.1

Polycom RealPresence DMA 7000, Virtual Edition 10.0.0.4

Polycom RealPresence Media Suite 2.8.2
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Compatible Products
The following table lists Polycom products and the third-party products that use standard, open protocols 
and Polycom expects these products to be compatible with this release. The list isn’t exhaustive but includes 
many products tested with previous versions of the RealPresence Resource Manager system.

Hypervisor Environments for Virtual Editions

Hypervisor Environments for Virtual Editions

VMware vSphere Platform

Microsoft Hyper-V

Polycom Video Endpoints

Polycom Video Endpoints

Polycom HDX

Polycom RealPresence Debut

Polycom RealPresence Centro

Polycom RealPresence Group Series (300, 310, 500, 550, and 700)

Polycom G7500

Polycom RealPresence Mobile 

Polycom RealPresence Desktop

Polycom RealPresence Immersive Studio

Polycom RealPresence OTX Studio

Polycom VVX 1500

Polycom CX5100

Polycom CX5500

Endpoint Peripherals

Endpoint Peripherals

Polycom RealPresence Touch

Polycom Touch Control

Polycom EagleEye Producer

Polycom EagleEye Director

Polycom EagleEye Director II
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Poly EagleEye Cube HDCI Camera

Poly EagleEye Cube USB Camera

Polycom Pano

Polycom UC Endpoints

Polycom UC Endpoints

Poly Trio 8800

Poly Trio 8500

Poly Trio 8300

Poly Trio Visual+

Poly Trio C60

Poly Trio VisualPro

Polycom SoundPoint IP 300/450/560/650/670

Polycom SoundStation IP 5000/6000/7000

Polycom SoundStation Duo

Polycom SoundStructure VoIP Interface (with VOIP card)

Polycom VVX 101/201

Polycom VVX 300/301/310/311

Polycom VVX 400/401/410/411

Polycom VVX 500/501

Polycom VVX 600/601

Polycom VVX 1500

Polycom VVX 150/250/350/450

Poly CCX 400

Poly CCX 500

Poly CCX 600

Poly CCX 700

Poly Studio

Endpoint Peripherals

Endpoint Peripherals
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System Constraints and Limitations
The RealPresence Resource Manager system is available in either an Appliance Edition or a Virtual Edition. 

Polycom Network Devices

Polycom Network Devices

Polycom RealPresence Collaboration Server, Virtual Edition

Polycom RealPresence Collaboration Server (RMX) 1500/2000/4000 with MPMx

Polycom RealPresence Collaboration Server (RMX) 1800/2000/4000 with MPMrx

Polycom RealPresence DMA 7000

Polycom RealPresence Access Director

Polycom VBP 7301

Polycom RealPresence Web Suite

Polycom RealPresence Media Suite

Third Party Products

Third Party Products

Acme Packet Net-Net Enterprise Session Director

Cisco Unified Communications Manager

Lifesize Express 200

Lifesize Team 200

Lifesize Express 220

Lifesize Team 220

LifeSize Room 220

Cisco TelePresence System SX80, SX20, SX10

Cisco TelePresence System 1700 MXP

Cisco TelePresence System Quick Set C90, C40, C20

Cisco 150 MXP

Cisco TelePresence System EX90

Cisco TelePresence System SX20

Cisco TelePresence MX200/MX300
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If your RealPresence Resource Manager system is licensed for more than 400 endpoints or over 20 network 
devices, the server you use must have 16 GB of RAM. 

● If you are using a Virtual Edition, verify that the system has enough RAM. You must create a new 
virtual machine with the required 16 GB of RAM and at least 160 GB of hard disk space.

● If you are using an Appliance Edition, you can use an R240, R230 or R640 server. These servers 
come with 16 GB RAM and support a maximum of 400 endpoints. See the Polycom Server 
Replacement Migration Guide on how to change servers.

Appliance Edition
You can install this version of RealPresence Resource Manager, Appliance Edition on the following Polycom 
servers:

● Polycom Rack Server 640 (R640)

● Polycom Rack Server 630 (R630)

● Poly Rack Server 240 (R240) — deployments with 400 endpoints or less

● Polycom Rack Server 230 (R230) — deployments with 400 endpoints or less

● Polycom Rack Server 220 (R220) — deployments with 400 endpoints or less

The maximum capabilities of the system differ according to which server you’re using.

The maximum capacities depends on a variety of factors including but not limited to:

• SIP registration refresh timer

• Call Statistics posting interval

• Provisioning heartbeat 

• Line status updates

• Directory lookups

• Multiple address book usage

• Software update requests

• System API usage

Capability
Maximum for Polycom Rack 
Server 640 and 630

Maximum for Poly/Polycom Rack 
Server 240, 230, and 220

Users 250,000 2000

User groups 1000 10

Areas No maximum No maximum

https://support.polycom.com/content/dam/polycom-support/products/uc-infrastructure-support/management-scheduling/dma/setup-maintenance/en/server-replacement-migration-guide-10.0.pdf
https://support.polycom.com/content/dam/polycom-support/products/uc-infrastructure-support/management-scheduling/dma/setup-maintenance/en/server-replacement-migration-guide-10.0.pdf
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Video and audio endpoints Maximum number of licensed video 
endpoints (50,000)

Maximum number of dynamically 
provisioned video endpoints (5000)

Maximum number of managed 
audio phones (20,000)

Recommended audio devices and 
video endpoints (mixed 
deployment) is 10,000 audio/5,000 
video

Maximum number of licensed video 
endpoints (400)

Maximum number of dynamically 
provisioned video endpoints (200)

Maximum number of managed 
audio phones (400)

Recommended number of mix of 
audio devices and video endpoints 
mixed deployment) is 200 audio/ 
200 video

Room entries No limit, but if the system has more 
than 1000 room entries, it could 
experience user interface 
performance issues

No limit, but if the system has more 
than 400 room entries, it could 
experience user interface 
performance issues

Site entries 500 500

Number of supported 
instances/servers

50 20

Maximum number of images 5 

The total size is under 8 GB

If you have more than 5 images or 
the total size is larger than 8 GB, 
delete unused images

5 

The total size is under 8 GB

If you have more than 5 images or 
the total size is larger than 8 GB, 
delete unused images

Number of integrated RealPresence 
DMA systems 
(or RealPresence DMA 
superclusters)

1 1

Number of integrated MCUs No maximum No maximum

Maximum text message length that 
can be sent to a hard endpoint 

100 characters 100 characters

Number of provisioning profiles 2000 20

Number of provisioning rules 1200 20

Number of displayed users in the 
Users page

500 500

Number of tiers in Address book 5 5

Number of Guest book entries 500 500

Capability
Maximum for Polycom Rack 
Server 640 and 630

Maximum for Poly/Polycom Rack 
Server 240, 230, and 220
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Supported Cluster Configurations
The Appliance Edition supports a two-server redundant configuration only with certain server combinations. 
The following table details the supported two-server local cluster configurations:

Virtual Edition
The RealPresence Resource Manager system is also available in an edition packaged for VM-based 
deployment. 

You can install RealPresence Resource Manager, Virtual Edition on the following VM-based environments:

● VMware: 6.0, 6.5, 6.7

● Microsoft Hyper-V: 2012 R2, 2016 

Polycom supports mixed Hyper-V/VMware environments, but Polycom has not tested all configurations and 
combinations.

Host Installation Guidelines 
The following table describes the VM host recommended deployment settings for an instance of the 
RealPresence Resource Manager, Virtual Edition system. It also shows the typical performance capacities 
of that deployment.

Number of User GUI login sessions 
per system and sessions per user

50 with 10 sessions per user 10 with 10 sessions per user

Calendar Connector proxy 
connections

200 RealPresence Group Series 
systems and 1000 RealPresence 
Mobile and/or RealPresence 
Desktop applications.

10 RealPresence Group Series 
systems and 100 RealPresence 
Mobile and/or RealPresence 
Desktop applications.

Supported Two-Server Local Cluster Combinations

Polycom Rack 
Server 630 (R630)

Polycom Rack 
Server 640 (R640)

Poly/Polycom Rack Server 240, 230, 220 
(R240, R230, R220)

Polycom Rack Server 
630 (R630)

Supported Not Supported Not Supported

Polycom Rack Server 
640 (R640)

Not Supported Supported Not Supported

Poly/Polycom Rack 
Server 240, 230, 220 
(R240, R230, R220)

Not Supported Not Supported Supported

Capability
Maximum for Polycom Rack 
Server 640 and 630

Maximum for Poly/Polycom Rack 
Server 240, 230, and 220
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Browser Requirements
Use one of the supported web browsers in the following table to administer a RealPresence Resource 
Manager system on Windows PC. Polycom recommends that you use Google Chrome for a better user 
experience.

Supported Microsoft Exchange
The RealPresence Resource Manager Calendar Connector supports Microsoft Exchange Server 2013 
15.0.516.032.

Installation and Upgrade Notes
See the Polycom RealPresence Resource Manager Getting Started Guide for instructions on how to install 
and license your product.

See the Polycom RealPresence Resource Manager Upgrade Guide for instructions on how to upgrade your 
product.

RealPresence Resource Manager Recommended Deployment Settings in a Virtual Environment

Component Deployment Settings

Virtual Cores 8

CPU 16,000 MHz

Memory 16 GB

Storage 160 GB

Performance Recommended maximum number of licensed video endpoints is 10,000

Recommended maximum number of managed audio phones is 10,000

Recommended maximum number of audio devices and video endpoints (mixed 
deployment) is 5000 audio/5000 video

Because of differences in hardware and VM environments, the performance information is provided 
for guidance purposes and does not represent a guarantee of any kind by Polycom.

Browser Requirement

Browser Supported Versions

Microsoft Internet Explorer 11.0

Google Chrome 45.0 or later
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If you are running a version prior to 8.0, you must sequentially apply every 8.x upgrade version until you get 
to 8.0. 

Customers running 8.0 and later can directly upgrade to the next version. For example, you can upgrade 
directly from 8.2 > 8.3 or from 8.3 > 8.4.

If you want to update to a maintenance release of the next feature release, you must first upgrade to the 
next feature release and then update to the maintenance release. For example, if you want to upgrade 8.1.x 
to 8.2.1, you must upgrade to 8.2 first, then update to 8.2.1.

You must be running on either version 10.0.0 or 10.0.1 to upgrade to 10.1 and later. 

Polycom supports the following upgrade and migration paths for RealPresence Resource Manager system.

System Licenses
You must activate and validate licenses for the RealPresence Resource Manager system before you can 
use RealPresence Resource Manager to manage your RealPresence products.

You must upgrade RealPresence DMA to 10.0 before upgrading RealPresence Resource Manager to 
10.5. If you don't upgrade RealPresence DMA first, it causes the RealPresence DMA integration to fail.

Current Version 
Intermediate

Upgrade

Intermediate

Upgrade

Intermediate

Upgrade

Intermediate

Upgrade

Intermediate 
Upgrade

Final 
Upgrade

8.0.x 8.1 8.2 8.3 8.4 9.0 9.0.1

8.2.x 8.3 8.4 9.0 9.0.1

8.3.x 8.4 9.0 9.0.1

8.4.x 9.0 9.0.1

9.0.x 10.0.0 10.0.1

10.0.0 10.0.1

10.0.x 10.1

10.1 10.2

10.2 10.3

10.3 10.4

10.4 10.5

10.5 10.6

10.6 10.7

10.7 10.8

10.8 10.9
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When products are connected to the RealPresence Resource Manager system, licensing remains active. If 
the RealPresence Resource Manager system goes offline for any reason, licensing remains active for up to 
14 days.

General Note on Analytics
When you accept the End User License Agreement (EULA) for the RealPresence Resource Manager 
system, you can select the Automatically send usage data check box. This option enables your system 
to send various types of usage data to a Polycom collection point 
(customerusagedatacollection.polycom.com). As this data is used to continually improve the product, 
Polycom recommends that you keep the setting enabled. See the Send Usage Data section in the 
RealPresence Resource Manager Operations Guide for a description of the type of data your system sends.

Enable or Disable the Automatically Send Usage Data Option
You can view or change your selection for the Automatically send usage data option.

To view or change your selection for the Automatically send usage data option:

1 On the system web interface, go to Admin > Server Settings > Licenses in the web interface. 

2 Select or clear the Automatically send usage data check box.

3 Select Update.

View the Data
You can view the data your RealPresence Resource Manage system sends to Polycom.

To see the data your RealPresence Resource Manage system sends to Polycom:

1 Go to Admin > Maintenance > System Log Files.

2 Select Roll Logs  to roll the logs. 

3 Save the log archive to your local machine. 

4 Unpack the log archive. 

The analytics.json file in the /var/log/polycom/cma directory contains the data that your 
system sends to Polycom.

Resolved Issues
The following table lists resolved issues in this release. 

If your local DNS server doesn’t resolve customerusagedatacollection.polycom.com, the

analytics service in the RealPresence Resource Manager system queries the Google DNS server.
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Resolved Issues

Category Issue 
Number

Found in 
Release

Description

Application EN-182262 10.8 The RealPresence Resource Manager backup file size is big. To reduce 
the size, purge the CDR participant and conference tables.

Application EN-181102 10.7 After a RealPresence Resource Manager restart, the reg.1.address 
parameter reverts back to its value in an old CSV file, causing phones to 
unregister.

Application EN-171554 10.8 If you assign the line URI to phones manually or by importing their CSV 
files, their protocol_supported flag setting is incorrect.

CPU EN-164661 10.4 The RealPresence Resource Manager system web interface may not 
stable due to a memory leak.

CPU EN-160037 10.7 After upgrading RealPresence Resource Manager from 10.4, the 
RealPresence Resource Manager server has intermittent high CPU usage.

CPU EN-165869 10.7 RealPresence Resource Manager becomes slow and unresponsive on the 
endpoint configuration profile association page.

CPU EN-132061 10.5 Sometimes, the RealPresence Resource Manager memory and CPU 
usage is up to 100%.

Endpoint EN-170011 10.4 RealPresence Desktop can’t log in to RealPresence Resource Manager.

Endpoint EN-173963 10.8 RealPresence Resource Manager fails to provision Poly Studio X30 or 
Poly Studio X50 using attributes with names that contain capital letters. 
The attribute names are case insensitive in RealPresence Resource 
Manager.

Endpoint EN-177413 10.7 When trying to export endpoints in Endpoint > Monitor View>More > 
Import/Export UC-Managed Endpoints, RealPresence Resource 
Manager prompts An error has occurred. 

Endpoint EN-153783 10.7 (Dynamic Management Only) RealPresence Resource Manager may fail 
to provision RealPresence Group Series due to the changed source port 
number of RealPresence Group Series during the NTLM authentication.

Filter En-166746 10.7 When using Filter > Connection Status to search offline endpoints on the 
Endpoint > Monitor View page, RealPresence Resource Manager shows 
some online endpoints.

License EN-115517 10.4 RealPresence Resource Manager 10.9 should provide a more robust 
mechanism for validating licensing and service contracts for perpetual 
license owners and avoid upgrade failures for perpetual license owners.

Memory EN-168807 10.7 Sometimes, RealPresence Resource Manager has a memory leak 
problem.

Provisioning EN-173393 10.8 If you provision Poly Studio X30 with RealPresence Resource Manager 
10.8, the endpoint doesn’t provide a SIP dial string reservation in its CSV 
file, user account, or machine account.



 RealPresence Resource Manager Release Notes Version 10.9

Polycom, Inc. 19

Known Limitations
The following table lists known limitations that may be experienced when the RealPresence Resource 
Manager system interoperates with other Poly products.

User 
Interface

EN-181530 10.4 The RealPresence Resource Manager system web interface becomes 
unstable after changing the provisioning polling time from 30 minutes to 1 
minute. 

User 
Interface

EN-180673 10.8 You must log out and then log in to get certain options. For example, 
Reboot Endpoint in Monitor View > More.

Known Limitations

Issue ID Description Workaround

EN-178918 The Group Series systems continue to display a meeting reminder 
on the screen every minute until the actual start time passes, even if 
you’ve already joined the meeting. This only affects Group Series 
systems that are registered to RealPresence Resource Manager 
Calendar Connector.

None.

EN-89957 The RealPresence Resource Manager system may fail to add the 
following instances by creating a new image with static IP:

• RealPresence Access Director instance

• RealPresence DMA instance

Sometimes, you can add the instance, but the IP address of the 
instance in the RealPresence Resource Manager system is not 
same as the specified static IP.

Deploy the RealPresence 
Access Director OVA on a 
virtual machine, and then 
add the existing instance to 
RealPresence Resource 
Manager.

EN-88183 The RealPresence Resource Manager system fails to add a 
RealPresence Web Suite Experience Portal instance by creating a 
new image.

Deploy the RealPresence 
Web Suite Experience Portal 
OVA on a virtual machine, 
and then add the existing 
instance to RealPresence 
Resource Manager.

EN-85432 After disabling the CBC Ciphers on the RealPresence Resource 
Manager system, RealPresence Resource Manager fails to 
communicate with RealPresence Access Director.

None.

EN-59844 The RealPresence Resource Manager system fails to provision VVX 
1500 after integrating with Enterprise Directory by SMB version 2.0.

VVX 1500 doesn’t support 
SMB version 2.0. Use SMB 
version 1.0.

EN-59501 Sometimes the software update status on RealPresence Resource 
Manager indicates an update of a Pano system is in progress when 
it is not. This occurs when manually checking for updates from 
RealPresence Resource Manager in the Pano system web interface.

None.

Resolved Issues

Category Issue 
Number

Found in 
Release

Description
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Known Issues
The following table lists known issues and suggested workarounds for RealPresence Resource Manager 
10.9.

These release notes do not provide a complete listing of all known issues that are included in the 
software. Issues not expected to significantly impact customers with standard voice and video 
conferencing environments may not be included. In addition, the information in these release notes 
is provided as-is at the time of release and is subject to change without notice.

Known Issues

Category Issue ID Found in 
Release

Description Workaround

Application EN-135775 10.5 If you log in with your Active Directory account, you 
don’t get an accurate display of failed login 
attempts.

None.

Application EN-138778 10.4 Occasionally, you can’t access the RealPresence 
Resource Manager user interface if a database 
query is stuck.

None.

Application EN-154177 10.4 RealPresence Resource Manager occasionally 
deletes all territories if it can’t reach Polycom 
RealPresence RealPresence Distributed Media 
Application (DMA).

None.

Alert EN-151647 10.4 RealPresence Resource Manager reports an 
unnecessary IDSDetected alert every few months.

None.

Alert EN-150531 10.4 RealPresence Resource Manager may report a 
large number of LDAP failure alerts by mistake.

None.

Conference EN-167409 10.7 Point-to-point calls show as connected on the 
RealPresence Resource Manager Conference > 
Monitor View page even after the call is 
disconnected.

None.

Endpoint EN-181087 10.8 After you import CSV files to create endpoints in 
RealPresence Resource Manager, the system 
doesn’t clean up the CSV files from the /var/temp 
folder.

None.

Endpoint EN-174804 10.8 RealPresence Resource Manager fails to provision 
Poly Studio X30 and Poly Studio X50 using 
homeScreen.backgroundImage.

None.

Endpoint EN-153544 10.6 (Version 10.6 and later, Phone Only) The Call Info 
section may show incorrect SIP call status.

None.

Endpoint EN-142624 10.3 Rebooting endpoints from their endpoint group may 
fail.

None.
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Localization EN-168072 10.7 RealPresence Resource Manager fails to assign an 
H.323 ID in a language other than English via the 
endpoint naming function.

None.

Site 
Topology

EN-147025 10.6 On the Edit Site-Link page, the values of From 
Site and To Site show reversed.

None. This issue 
doesn’t affect 
this feature.

Site 
Topology

EN-146794 10.6 RealPresence DMA fails to download site topology 
from RealPresence Resource Manager when you 
only specify the ISDN Number Range but don’t set 
any values to the Digits in Call Line Identifier and 
Digits in Short Phone Number fields on the ISDN 
Number Assignment tab when editing a site.

Specify the fields 
on the ISDN 
Number 
Assignment tab 
correctly.

Starting up EN-151397 10.3 After running RealPresence Resource Manager for 
a long time with the same version, RealPresence 
Resource Manager may fail to start up due to limit 
disk space.

Contact Poly 
PGS to clean up 
the server.

Upgrade EN-170928 10.8 After upgrading RealPresence Resource Manager 
to 10.8 or later, some attributes may be filled with 
the value 
$AudioProvisionProfile.getProvisionAttrib
uteValue($key).

Reset the 
attributes to the 
correct values.

Upgrade EN-165993 10.7 RealPresence Resource Manager shows status for 
the phone as offline after the heartbeat times out 
while the phone is online.

Set 
apps.statePoll
ing.responseMo
de to 0.

RealPresence 
Resource 
Manager doesn’t 
support 
apps.statePoll
ing.responseMo
de = 1.

User 
Interface

EN-170038 10.7 After you download Poly Trio phone logs from the 
RealPresence Resource Manager Monitor View, 
the log size doesn’t show correctly in Phone Files 
Rotation Settings.

None.

User 
Interface

EN-181012 10.7 If a site name has trailing spaces, RealPresence 
Resource Manager doesn’t upgrade territories ain 
the RealPresence DMA super cluster.

None.

User 
Interface

EN-173102 10.8 RealPresence Resource Manager fails to save the 
minute value in the Start Time field in the 
Maintenance Window.

None.

Known Issues

Category Issue ID Found in 
Release

Description Workaround
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Get Help
For more information about installing, configuring, and administering Polycom products, refer to Poly Online 
Support Center.

To find all Polycom partner solutions, see Polycom Global Strategic Partner Solutions. 

The Poly Community
The Poly Community gives you access to the latest developer and support information. Participate in 
discussion forums to share ideas and solve problems with your colleagues. To register with the Poly 
Community, create a Poly online account. When logged in, you can access Poly support personnel and 
participate in developer and support forums to find the latest information on hardware, software, and partner 
solutions topics. 

User 
Interface

EN-153553 10.7 On the RealPresence Resource Manager local 
interface, the warning message says that the 
maximum log stream size for Server is 3 GB.

This is a display 
issue. It should 
be 30 GS.

User 
Interface

EN-188741 10.9 Poly Trio Visual+ or Poly Trio VisualPro paired 
devices only appear in Endpoint Monitor view and 
not in Peripheral view.

None.

User 
Interface

EN-188740 10.9 Though daisy-chained Poly Trio devices appear on 
the Endpoint >Peripherals view correctly, they 
always appear as offline in the Endpoint >Monitor 
view.

They don’t appear as a component of the primary 
device but as an additional primary device. 
Daisy-chained Trio 8500, Trio 8800, or Trio C60 
systems may consume additional licenses.

None.

User 
Interface

EN-181809 10.9 After you reboot RealPresence Resource Manager 
or reprovision Poly Trio Visual+ or Poly Trio 
VisualPro, RealPresence Resource Manager fails 
to display the disconnection status of Poly Trio 
Visual+ or Poly Trio VisualPro.

Reboot Poly 
Trio.

User 
Interface

EN-189083 10.9 In Endpoint > Monitor View, the Endpoint Name 
of Poly Trio VisualPro displays correctly as Trio 
VisualPro, but its model type displays incorrectly 
as Trio Visual+.

None.

User 
Management

EN-175265 10.1 You may fail to search for new created user or user 
groups when there they’re thousands of users in 
your RealPresence Resource Manager system.

None.

Known Issues

Category Issue ID Found in 
Release

Description Workaround

https://www.poly.com/us/en/support
http://support.polycom.com/PolycomService/support/us/support/strategic_partner_solutions/index.html
http://community.polycom.com/
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Copyright and Trademark Information
Copyright© 2020, Plantronics, Inc. All rights reserved. Poly and the propeller design are trademerks of Plantronics, Inc. 
All other trademarks are property of their respective owners.

Plantronics, Inc. (Poly — formerly Plantronics and Polycom)

345 Encinal Street Santa Cruz, California 95060

End User License Agreement By installing, copying, or otherwise using this product, you acknowledge that you have 
read, understand and agree to be bound by the terms and conditions of the End User License Agreement for this 
product. The EULA for this product is available on the Poly Support page for the product.

Patent Information The accompanying product may be protected by one or more U.S. and foreign patents and/or 
pending patent applications held by Plantronics, Inc.

Open Source Software Used in this Product This product may contain open source software. You may receive the 
open source software from Poly up to three (3) years after the distribution date of the applicable product or software at 
a charge not greater than the cost to Poly of shipping or distributing the software to you. To receive software information, 
as well as the open source software code used in this product, contact Poly by email at typeapproval@poly.com.

Limitation of Liability Poly and/or its respective suppliers make no representations about the suitability of the 
information contained in this document for any purpose. Information is provided "as is" without warranty of any kind and 
is subject to change without notice. The entire risk arising out of its use remains with the recipient. In no event shall Poly 
and/or its respective suppliers be liable for any direct, consequential, incidental, special, punitive or other damages 
whatsoever (including without limitation, damages for loss of business profits, business interruption, or loss of business 
information), even if Poly has been advised of the possibility of such damages.

Disclaimer While Poly uses reasonable efforts to include accurate and up-to-date information in this document, Poly 
makes no warranties or representations as to its accuracy. Poly assumes no liability or responsibility for any 
typographical or other errors or omissions in the content of this document.

Customer Feedback We are striving to improve our documentation quality and we appreciate your feedback. Email 
your opinions and comments to DocumentationFeedback@poly.com. 

Support Visit the Poly Support Center for End User License Agreements, software downloads, product documents, 
product licenses, troubleshooting tips, service requests, and more.

http://support.polycom.com/
http://support.polycom.com/
http://support.polycom.com/
mailto:typeapproval@poly.com
mailto:typeapproval@poly.com
mailto:typeapproval@poly.com
http://support.polycom.com/
http://support.polycom.com/
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